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Preface

This manual, Quick Start to Using the OpenStep Desktop, provides a brief
introduction to the OpenStep User Interface. It introduces you to the OpenStep
color, sound, graphics, and text applications. For a more detailed introduction
to these applications, see Using the OpenStep Desktop.

Who Should Use This Book
If you are just beginning to use OpenStep applications and if you are
unfamiliar with using Sun systems, this manual is the most direct path to the
basics you need to get started. For step-by-step instructions to managing your
workspace and to using the applications that get you through everyday tasks,
refer to the manual Using the OpenStep Desktop.

How This Book Is Organized
This book contains the following:

Chapter 1, “Basics,” explains the basics of the OpenStep desktop environment,
including logging in and out, using the workspace and the mouse, choosing
commands, and setting a password.

Chapter 2, “Using Windows,” describes how to use windows in the OpenStep
desktop environment.

Chapter 3, “Getting Help,” tells you how to use OpenStep on-line help.
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Chapter 4, “Applications,” discusses how you run OpenStep applications,
including running multiple applications, switching applications, and hiding
applications.

Chapter 5, “Files,” describes the OpenStep File Viewer and application dock. It
tells you how to find files and folders, and create, open and save files.

Chapter 6, “Editing,” provides the basics of editing files, including typing,
deleting, moving, and copying text.

Chapter 7, “Organizing,” discusses ways of organizing your files and folders
in the File Viewer. It provides procedures for renaming, moving, copying,
linking, and deleting files and folders, and creating new folders.

Chapter 8, “Color,” tells you how to create, capture, save, and use color in
your documents.

Chapter 9, “Printing,” explains how to prepare a file for printing and how to
print it.

Related Books
For detailed information on the OpenStep user interface, see Using the
OpenStep Desktop. For user interface information from the programmer’s point
of view, see OpenStep User Interface Guidelines.
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What Typographic Changes Mean
The following table describes the typographic changes used in this book.

Table P-1 Typographic Conventions

Typeface or
Symbol Meaning Example

AaBbCc123 The names of commands,
files, and directories;
on-screen computer output

Edit your .login  file.
Use ls -a  to list all files.
machine_name% You have mail.

AaBbCc123 What you type, contrasted
with on-screen computer
output

machine_name% su
Password:

AaBbCc123 Command-line placeholder:
replace with a real name or
value

To delete a file, type rm filename.

AaBbCc123 Book titles, new words or
terms, or words to be
emphasized

Read Chapter 6 in User’s Guide.
These are called class options.
You must be root to do this.
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Basics 1

Logging In
To begin working with a computer, you log in. The login process prevents
unauthorized people from using your computers, files, and folders.

To log in, you type in your user name and password. A typical login process
consists of these steps:

1. Type your user name at the login prompt.
If you make a mistake, press the Backspace key to back up over each
character you want to retype.

2. Press the Return key.
The computer displays the password prompt.

3. Type your password at the password prompt.
Your password is not displayed. In most cases, you will be given an initial
password for your computer, which you can change later on.

4. Press the Return key again.

If you typed your user name and password correctly, you should enter the
OpenStep workspace.
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Figure 1-1 A User Named Starr Logs In

If you make mistakes while typing, a message informs you that your login
attempt is unsuccessful. If this occurs, go back to step 1 and try logging
in again. If you continue to have problems, contact your system administrator.

Entering the Workspace
The images or objects in the workspace represent files, application programs,
and other items you can work with on your computer. Your workspace may
not exactly match the one in Figure 1-2, but it will have many of the same
features.

• Icons, which are small pictorial representations of things you work with in
the workspace.

• The application dock (or dock, for short) which is a column of icons along the
right edge of the workspace. Most of the dock icons represent applications.
The Sun icon at the top of the dock represents the Workspace Manager

application, which you use to manage your computer.

• The File Viewer window, which gives you access to your files.

• Menus, which are lists of commands such as Edit and Log Out that you can
choose to make the Workspace Manager do something.

• A pointer, which is the small black arrow that moves when you move the
mouse. You move the pointer to point to objects on the screen.

console login: starr

password: |

Your password does not appear
as you type.

Type your user name.
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Figure 1-2 The Workspace

Using the Mouse
To get your computer to do things, you act on objects in the workspace. Most
of the time, you use the mouse. Practice these basic mouse techniques:

• Slide the mouse on the mouse pad.

• Point to an object on the screen by moving the mouse to position the cursor
on top of the object.

• Click by pointing to an object and, without moving the mouse, pressing and
releasing a mouse button.

Click an icon in the File Viewer window. The icon is highlighted.

The File Viewer provides
access to your files.

A menu lists commands you
choose to make an
application do something.

An icon is a small pictorial
representation of
something, like a file or
application.

This column of icons is the
application dock, or dock,
for short.
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For detailed information on using the mouse that accompanies your Sun
workstation, refer to the hardware or user’s manual that came with your
system.

Figure 1-3 Using the Mouse

• Press by pointing to an object and, without moving the mouse, pressing and
holding down the mouse button.

Press a black arrow button (if there is one) in the File Viewer window. As
long as you press, the button is highlighted; information may also move in
the window.

The minimize button.
Click here to turn the
File Viewer into a
miniwindow. Double-
click on the miniwindow
to restore the File
Viewer.

The title bar. Click here,
hold the mouse button
down, and drag the
entire window.

Icons which represent
files and folders on your
computer.

The down-scrolling
arrow. Press on it.
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• Drag by pointing to an object, pressing and holding down a mouse button,
moving the cursor to a new location (by sliding the mouse), and then
releasing the mouse button.

Drag the title bar at the top of the File Viewer window. The window moves
in the workspace.

The cursor changes shape as you work. The most common forms are:

Setting a Password
Change your password often so that it remains secure. To set your password,
follow these procedures.

1. Move your pointer to the application dock and double-click on the
Preferences icon.

The pointer changes to a watch for a moment, and then the Preferences
window opens. Notice that the main menu for the Preferences application
replaces the main menu that is currently displayed.

Table 1-1 Pointer shapes

Shape Purpose

An arrow, for pointing to objects.

An I-beam, for editing text.

The question mark, for getting on-line help about an object.

The watch, which indicates that the application is busy, usually with an
instruction you gave. You can wait or switch to another application.
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2. There is a row of buttons across the top of the Preferences window; click
on the password button.
See Figure 1-4 for the location of the password button. If the button is not
visible, drag the sliding knob (just below the buttons) to bring it into view.

Figure 1-4 The Preferences Window

3. At the insertion point, type your current password (if any).
You won’t see the characters as you type.

4. Click on the OK button in the window.

5. Type your new password in the text field and click on the OK button.
The Preferences application asks you to verify your new password by
typing it again.

Note – A good password is hard to guess but easy to remember. Use a
combination of letters, numbers, and other characters, such as punctuation
marks.

Type your password in this
text field.

Click on the password button

Drag this knob sideways to
bring the password button
into view.
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6. Type your new password again and click on OK.
If you typed correctly, a confirmation panel confirms that the new password
is in effect; otherwise, the Preferences application asks you to repeat the
process.

7. Click on the confirmation panel’s OK button.

8. Choose the Hide command from the Preferences main menu.
Move your pointer to the Preferences menu, in the upper left corner of your
screen, and click on the Hide command.This hides the Preferences
application. For more information on hiding applications, see “Hiding an
Application” on page 4-4.
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Choosing Commands
One way to tell an application what to do is by choosing a command from a
menu. Each application has a main menu that appears in the upper left of the
workspace while you’re working in the application.

• To choose a command, click it in the menu.

The command is highlighted and carried out.

A dimmed command (shown in gray rather than black) is currently
unavailable.

A command with an arrow  opens another menu, called a submenu, which
contains more commands.

The submenu stays open until the next time you choose a command from the
first menu.

Figure 1-5 Opening a Submenu

• To keep a submenu open, detach it by dragging its title bar.

Clicking here opens the File
submenu. Clicking a second
time will close the submenu.
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Figure 1-6 Detaching a Submenu

• To close a detached submenu, click the close button  in its title bar.

Figure 1-7 Closing a Detached Submenu

Dragging here detaches the
submenu

Clicking here closes the
detached submenu.
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• To choose a command, you can also use a keyboard shortcut.

You can choose a command from the keyboard by holding down the
Command key while typing the character shown next to the command.

When you choose a command that’s followed by an ellipsis (...), a panel asks
for additional information about how to carry out the command.

Figure 1-8 Using Keyboard Shortcuts for Commands

Logging Out
When you’re done with a work session, you log out to quit all applications that
are running.

Before logging out, make sure you save any work you’ve done in an
application, or your work will be lost. (To learn more about saving, see
Chapter 5, “Files.”)

1. Choose the Log Out command from the Workspace menu.
(If the Workspace menu isn’t visible, click in the File Viewer window or
double-click on the Sun icon at the top of the dock to make the Workspace
menu appear.)

The Log Out panel opens. If you change your mind about logging out (or if
you choose Log Out by accident), click on the Cancel button in the Log Out
panel.

2. Click on the Log Out button in the panel.
If an application contains unsaved work, a panel may open, giving you a
chance to save your work.

Logging out closes all open window, quits all running application, and
returns you to the desktop.

Hold the command key
down and type “f” to
choose this command.

Hold the command key and
the Shift key down and type
“p” to choose this command.
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Figure 1-9 Logging Out

Choose Log Out from the
Workspace menu.

When the confirmation panel
opens, click the Log Out button.
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Your computer displays text, pictures, and other kinds of information in
rectangular frames called windows. Several windows may be open in your
workspace at a time. This chapter describes how to work with windows in the
OpenStep desktop environment.

Organizing Windows
Since each window has its own purpose—some display documents you are
working on, others display options that are available for the work that you are
doing, and others simply display messages from your computer—you might
want to make some windows larger and others smaller, move some windows
completely out of the way for a time, and so on. This chapter shows you
techniques for doing these things.

♦ To organize the windows in your workspace, you can change their sizes,
shapes, and positions.

Techniques for this are illustrated in Figure 2-1.

Using Windows 2
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Figure 2-1 Organizing Your Workspace

To put a window aside temporarily,
click its minimize button. This changes
it to a miniwindow that appears at the
bottom of the workspace.

To restore a minimized window,
double-click on the miniwindow

To move a window, press on its title bar
and drag.

To change a window’s size, drag the
resize bar. You can drag out, to make
the window larger, or in to make the
window smaller. Drag one of the resize bar’s end regions

to change the window’s width.
Drag the resize bar’s middle region to
change the window’s height.
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Reordering Windows
The windows in your workspace can overlap. A window can cover part of
another window or all of it. Windows can be stacked up, and a window that is
visible on your display may actually be covering several other windows.

Because your mouse pointer can only be in one place at a time and you can
only type in one window at a time, you are limited to working in the window
that is “in front” (or “on top”). If you want to work in a different window, use
your mouse to bring it to the front:

♦ To bring a window forward, move your mouse until the pointer is over
the window and click on it. Make sure you don’t click on a button (such
as the window’s close button) when you click on the window.

The window moves to the front. In most cases its title bar turns black, to
indicate that it is now the key window. Whatever you type on your keyboard will
appear in the key window.

Remember that clicking in a window also makes the window’s application the
active application (if it isn’t already). “Switching Between Applications” on
page 4-3 has more information about the active application.
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Figure 2-2 Changing the Order of Windows in the Workspace

The key
window’s title
bar is black.

If you want to work in this window,
click on it. It will become the key
window and move to the front.
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Scrolling
When a window contains more than it can display at one time, you can scroll to
see more. If a document window displays one page of a 25-page document, for
example, you scroll to see the other pages.

In many windows, you scroll using a scroller—a gray bar with a knob and
scroll buttons. Figure 2-3 shows an example of a scroller.

Figure 2-3 A Horizontal Scroller

Horizontal scrollers scroll left and right while vertical scrollers are for scrolling
up and down.

♦ You use scrollers by clicking on a scroll button. In some cases, you scroll
using buttons that aren’t in a scroller but that stand alone. (A dimmed
button means you can’t scroll any further in that direction.)

Figure 2-4 shows you these techniques for operating a scroller.

Scroll buttons Scroll knob
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Figure 2-4 Using the Scroller

Note – The scroll knob’s size and position indicate how much of the total
information you’re viewing and where you are in the document. For example,
if you’re on page 2 of a 3-page document, the vertical scroller fills the middle
third of the bar.

Click in the gray bar to scroll
quickly—the knob jumps to the
position under the cursor as
though you dragged it there.

Drag the scroll knob in the bar
to scroll continuously.

Click on a scroll button to scroll by a
line or other increment in the
direction the button points. Press
the button to scroll continuously by
increments.
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This chapter explains how you get on-line help while using OpenStep. You can
get help for an object on the screen, use the Help table of contents to look up a
task, use the Help index to look up a topic, or use the Help search feature to
search for any help text that contains a word or phrase you type in.

Clicking for Help
When you’re working in the File Viewer, Mail, Edit, and some other
applications, you can get help with your work by “help-clicking” on a screen
object.

1. Hold down the Help key on the keyboard.
The pointer changes to a question mark ( ).

If your keyboard doesn’t have a Help key, try getting the question mark
pointer by pressing F1, or by pressing the Alt and Control keys at the same
time.

2. Click on the object you want help with; it can be a menu command,
window, button, or other type of object.
The Help panel opens, with information about the object you clicked.

Note – If you want help with Help, use the question mark pointer to choose
the Help command in the Info menu.

Getting Help 3
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3. You can scroll the Help panel to read more, or click on any word or phrase
marked with a  button to get help on a related topic.
For information about scrolling, see “Scrolling” on page 2-5.

Figure 3-1 After Help-Clicking on the Print Command

Hold down the Help key
or the F1 key and click
on the object for which
you want help.

Information about the
object is displayed on the
Help panel.
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Getting Help for a Task or Topic
You can get help with tasks or topics.

To get help with a specific task, look through the Help panel’s table of contents
and choose the task you are trying to perform.

1. Choose Help from the Info submenu.
The Help panel opens. If the Help panel is already open, click in it to make
it the key window.

2. Click on an entry in the Help table of contents.
Instructions for the task you chose appear in the Help panel. You can scroll
the table of contents to find the task you want help with.

.

Figure 3-2 Choosing a Task in the Table of Contents

To get help with a specific topic, look through the Help panel’s index and
choose the topic you want to learn about.

1. Choose Help from the Info submenu.

Get help with a task by
clicking on it in the table of
contents.
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2. Click on the Help panel’s Index button.
An index of help topics appears.

3. Click on the topic you want help with.
Help about the topic you clicked appears in the Help panel

.

Figure 3-3 Choosing a Topic in the Help Index

Click on the Index button

Choose a topic from the index
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Searching for a Word or Phrase
If you can’t find what you need with the Help panel’s table of contents and
index, you can use its search feature, which looks for help text containing a
word or phrase that you type.

1. Open the Help panel.
You can open the Help panel by choosing Help from the Info menu, or by
clicking on an object with the question mark pointer.

2. Click in the text field at the top of the Help panel and type the word or
phrase you want to get help with.

3. Click on the Find button.
The Help panel searches for help that contains the word or phrase you
typed. The first topic that contains the word or phrase you typed appears in
the Help panel; the word or phrase is highlighted.

4. To find another topic that contains your word or phrase, click on the Find
button again.
The next topic that contains the word or phrase appears in the panel.

Figure 3-4 Getting Help by Typing in a Search Word

Type the keyword or phrase
you want help with in the
field.

Then click on the Find
button.

The keyword or phrase you
typed is highlighted.
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OpenStep comes with several applications, such as Edit and Mail. You, or someone
else at your workplace, may have added more applications to your desktop.
Each application allows you to do different kinds of work, so you need to
know techniques such as starting, quitting, hiding, and switching applications.

Starting Up an Application
You start an application with your mouse, by clicking on its icon. You can keep
an application icon in the workspace’s application dock, which makes it easy
to find, but you can also start applications that are not in the dock.

♦ To start an application from the dock, double-click on its icon.

The icon is highlighted for a moment, and then the application’s main menu
appears. One or more windows may also open.

Figure 4-1 Application Icons Show Application Status

Not running Starting up Running

Applications 4
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Notice that before you start up an application in the dock, its icon has three
dots in its lower left corner. After you start up the application, the dots are
removed, to indicate that the application is running.

See “Opening a File From the File Viewer” on page 5-9 for information about
adding applications to the dock.

♦ To start an application from the File Viewer, double-click on its icon in
the File Viewer.

You can also double-click on an icon that represents a document, which
starts the application and opens the document. See “Opening a File From
the File Viewer” on page 5-9 for more information on these techniques.

Figure 4-2 The Mail Application Starts

The application may also
open one or more
windows.

When you first start up
an application, the
Workspace menu goes
away and the
application’s main menu
appears in its place.
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Using Multiple Applications
You can run several applications at once—for example, you can create a
document in Edit and use Mail to communicate with your co-workers.

Running Multiple Applications

♦ Start up each application you want to run. You can start them from the
dock, the File Viewer, or both.

Each time you start up an application, its main menu opens and replaces
any menus that were previously visible. Most applications also open one or
more windows, which can cover any windows that are already open.

Switching Between Applications

Although several applications might be running, you work in only one at a
time—the active application. The active application is the one whose menu is
showing.

When several application are running, you can switch to the one you want
to work in.

♦ To switch from one application to another, move the mouse pointer over
one of its windows and click on the window. Or double-click on the
application’s icon.

When you switch applications, the menus switch. If you switch by clicking in
a window, it comes to the front.

Starting Edit Starting Preview
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Figure 4-3 Edit Has Started After Mail

Hiding an Application
If you’re done working in an application for now but may use it later in the
work session, you can hide the application to get its windows out of the way.

♦ To hide an application, choose Hide from its main menu.

All of the application’s windows disappear, but the application is still
running and you don’t lose any unsaved work. If other applications have
windows open, one of those applications becomes active.

By hiding applications, you can have several applications running and easily
accessible. However, your workspace remains free of windows you’re not
using at the moment.

Clicking in an
application’s window
activates the application.

When an application
starts up, it becomes the
active application and its
main menu replaces the
previous application’s
menu.
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When you’re completely done using an application, quit the application—as
described in“Quitting an Application” on page 4-8.

Figure 4-4 Mail Is Hidden

Note – Hide applications to unclutter your workspace when several
applications have windows open.

Unhiding an Application
When you want to work again in a hidden application, you can unhide it.

The Mail menu and
window are removed from
the screen without
creating a miniwindow, the
Edit menu replaces the
Mail menu, and the Edit
window becomes the
key window.

The Mail icon in the dock
does not have the three
dots, which indicates that
Mail is still running.
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♦ To unhide an application, double-click its icon.

Its windows reappear—just as though the application hadn’t been
hidden—and the application becomes the active application.

If you hide the Workspace Manager, you can unhide it by double-clicking on
the Sun icon at the top of the application dock.

Note – Whenever you want to work in an application, you can get to it
(whether or not it’s hidden) by double-clicking on its icon.
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Figure 4-5 Mail Reappears After It Is Unhidden

To unhide Mail, double-click
on its icon. The Mail menu
and the Active.mbox window
reappear.
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Quitting an Application
When you’re completely done working in an application, quit the application.

♦ Choose Quit from the application’s main menu.

If you haven’t saved your work in the application, a panel gives you a
chance to save before quitting. Then the application’s windows are closed.

If you don’t save your work when you quit, it will be lost. (For more
information on saving, see Chapter 5, “Files.”)

When you log out at the end of a work session, all running applications quit
automatically.

Note – Hide rather than quit applications that you plan to use later in your
work session—it takes less time to unhide an application than it does to start it
up again.
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Figure 4-6 After Quitting Mail

When you quit an
application, the ellipsis (...)
reappears in its icon,
indicating that the
application is no longer
running.



4-10 Quick Start to Using the OpenStep Desktop—September 1996

4



5-1

Your computer stores information—including documents you create—in files,
and uses folders to group and organize files. A file might contain a memo you
write, a drawing you did with a graphics application, even an application
itself. Folders can contain files and other folders.

The files and folders in your desktop are organized in a hierarchy, in which a
root folder, like a file cabinet, contains all of the other folders, each of which can
contain files and more folders. You can use as many levels of folders as you
want.

The File Viewer
You use the File Viewer to view and work with the files and folders in your
computer. They appear as icons in the File Viewer.

• At the top of the File Viewer is the shelf, where you can put icons of files or
folders you use often and want to keep handy.

• In the middle of the File Viewer is the icon path, which shows you where you
are in the file system. The highlighted icon at the right is the current file or
folder. The icons to the left of the current folder trace the path back up the
hierarchy to the root folder, which is represented by the workstation icon.

• At the bottom of the File Viewer, the current view displays the contents of the
current folder.

Files 5
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Figure 5-1 Starr’s Home Folder

When you log in, your home folder is the current folder, and its contents are
displayed as the current view. Your home folder is represented by a house icon
and has the same name as your user name. Figure 5-1 shows the file viewer
after a user named “starr” logs in; his home directory is the current folder (at
the end of the icon path), and the current view shows what the home folder
contains.

The shelf

The icon path.
The current folder
is highlighted.

The current view. The
current view displays the
contents of the current
folder. In this case, Starr’s
home folder contains a
number of other folders.
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Finding Files and Folders
You find files by opening folders to see their contents.

• To open a folder and display its contents in the current view, double-click on
its icon.

• To move up the hierarchy, to a more inclusive folder, click on its icon in the
icon path.

• To open a folder on the shelf, click on its icon there.

When you open a folder, its branch of the hierarchy appears in the icon path
with the folder’s icon selected, and its contents are displayed at the bottom of
the window.

Table 5-1 Types of Folders

Icon Type of Folder

Most folders are represented by this icon. Some have icons that indicate
something special about the folder’s contents or location.

 This icon identifies your home folder, which contains your files.

This icon identifies someone else’s home folder.

This icon identifies a folder which is a floppy disk.

This icon identifies the /net  folder, which contains folders that are
located on other computers on the network.
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It doesn’t matter where a folder is or what icon it has. You use the same
techniques with all folders.

Note – You can use the Clean Up Icons command in the View menu to
straighten up the current view of icons.

Figure 5-2 After Opening ReactionReports

Stocking the Shelf
The shelf is a place for holding files or folders you access frequently. By
clicking an icon on the shelf, you can quickly open the folder that contains it.

To display the contents
of a folder that appears
on the shelf or in the
icon path, click on its
icon.

To display the contents
of a folder that appears
in the current view,
double-click on its icon.
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In addition to your home folder (which is always on the shelf), you can stock
the shelf with other files or folders you want to get to quickly.

Putting a File or Folder on the Shelf

1. Select a file or folder by clicking on its icon, in either the icon path or the
current view.
Its icon is highlighted.

2. Drag the highlighted icon into an empty space on the shelf. Release the
mouse button when a ghost image of the icon appears.

Removing a File or Folder From the Shelf

♦ Drag the icon off the shelf—out of the File Viewer window and into the
workspace.

The icon is removed from the shelf, but the file or folder is not deleted from your
computer. You can still find it in the icon path or in the current view at the
bottom of the screen.
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Figure 5-3 Dragging ReactionReports  to the Shelf

Customizing the Application Dock
To add an application to the dock, you follow these procedures.

1. Using the File Viewer, find the application you want to add to the dock.
The standard locations for applications are the /usr/openstep/Apps
folder (only for applications supplied with OpenStep), the
/usr/local/openstep/Apps  folder for other applications that are widely
available on your network, and ~/openstep/Apps  for applications that are
available on just one computer.

Add an object to the shelf
by dragging its icon from
the icon path or the
current view.
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Note – The / symbol in a folder name stands for the root folder. To find a
folder when its name begins with the root folder, select the root icon (the icon
that looks like a computer) in the File Viewer’s icon path. When the root
folder’s contents appear in the current view, double-click the folder that comes
next in the path, and so on. The ~ symbol in a folder name stands for your own
home folder. To find a folder when its name begins with ~, select you home
folder icon (which is normally on the File Viewer’s shelf). When your home
folder’s contents are displayed, select the icon for the folder that comes next in
the path, and so on.

2. Select the application by clicking on it in the File Viewer.
The application’s icon appears in the icon path and is highlighted.

3. Drag the highlighted icon into an empty space in the application dock
and release the icon when a ghost image of it appears in the dock.

To remove an application from the dock, follow these procedures.

• If the application isn’t running, just drag its icon out of the dock—into the
workspace.

• If the application is running, hold down the Command key and drag it out
of the dock.
You can also Command-drag the recycler to remove it from the dock.

To use the application again, you can start it from the File Viewer.
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Figure 5-4 Moving an Application to the Dock

To install an application in
the dock, drag its icon from
the File Viewer to an empty
space in the dock. Release
the icon when a “ghost
image” of it appears.

You can’t remove the
Sun icon from the dock.
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Opening a File From the File Viewer
You can open any file by acting on its icon in the File Viewer.

1. Find the file by opening the folder that contains it.

2. Double-click on the file’s icon.
You can double-click on a file icon in the current view, on the icon path, or
on the shelf.

If the file is an application, it will start up. Otherwise, OpenStep will start
the application that created the file (if it isn’t already running) and open the
file in its own window.

You can tell what application a file will open in by the file’s icon, which
resembles the application’s icon. For example, if you double-click an Edit file
icon, Edit opens a window that displays the file’s contents.

Figure 5-5 Edit Application and Edit File Icons

When an application that isn’t in the application dock starts up, its icon
appears at the bottom of the screen. You can add the application to the dock by
dragging its icon to the dock. Otherwise the icon disappears when you quit the
application.

Edit application icon

Edit document icon
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Figure 5-6 Opening FestivalRelease.rtf  From the Viewer

Opening a File From Within an Application
When you’re working in an application, you don’t have to go to the Workspace
Manager to open a file. You can open it from within the application itself.

1. Choose Open from the application’s document menu. The document
menu may be titled Document, File, Project, or something else. It’s in the
main menu just below Info.
A panel with a browser opens. Browsers are lists of files and folders
displayed in one or more columns. At the top of each column is the name of
the folder that contains the files and folders in that column. With browsers
you can move quickly through a hierarchy of files and folders.

Double-clicking on the file
icon for FestivalRelease
has started up Edit and
opened the file in an Edit
window.
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2. Locate the file in the panel’s browser.

3. Click on the file to select it.
The file’s name appears in the Name field.

4. Click on OK.
The panel disappears and the file opens in its own window.

You can use the disk buttons on the Open panel to work with files on floppy
disks. For more information, see the Using the OpenStep Desktop.

Figure 5-7 Opening FestivalRelease.rtf  From Edit’s Open Panel

Creating a File
You can create a new file to store your work while you are using an
application.

1. Choose New from the application’s document menu.
A new, untitled window opens.

2. Do some work in the window, such as typing a new document.

Select the file’s name in the
right-hand column of the
browser and click on OK.
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3. Save the window’s contents to a file by choosing Save from the document
menu.
The Save panel opens. It contains a browser.

4. Use the browser to select the folder in which you want to save the file.

5. Type a name for the file in the Name text field.

6. Click on OK.
The name you chose appears in the window’s title bar, indicating that a file
has been created.

If you close the new window without saving your work, no file is created and
your work is lost.

Figure 5-8 Creating a File

Saving Changes to a File
The work you do in a file is not automatically saved, or stored permanently on
the computer’s disk storage. There are several ways to save your file.

After typing or drawing a
new document in an
empty window, choose
Save from the File
menu.

Use the browser to
select the folder in
which you want to
create the file.

This column shows any
files already in the
folder.

Type in the name you
are giving to the new file.
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You can save revisions you’ve made to a file.

♦ While working in the file, choose Save from the application’s document
menu.
The contents of the window are saved on the disk, replacing the last saved
version of the file.

You can also save a copy of your file under a different name.

1. Choose Save As from the Document menu.
The application’s Save panel opens.

2. Type a new name for the version you are working on.
Your version will be saved under this name. To remind yourself of what
you’ve done, you can use a name like YearEndReport_v6 or
ProductBrochure11/4.

3. You can use the browsers on the Save As panel to put the new version of
the file into the same folder as the original file or a different folder.
Saving to a different folder is described in “Creating a File” on page 5-11”.

4. Click on the OK button.
The original file is not modified. Your work is saved in a new file with the
new name you chose. You can continue working in the new file.

Note – You should save changes frequently, not just when you’re about to close
a file. You know when a window contains unsaved work if its close button is
partially drawn. After saving the close button returns to normal.
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This chapter covers the basic procedures for typing, correcting, and otherwise
working with text.

Typing and Inserting Text
In most applications, you type text the same way whether you’re editing a
document or entering a value in a field. When you type, the letters you type
will appear at the insertion point, which looks like this: |.

1. Click on the window in which you want to type.
The window you click on becomes the key window (if it isn’t already), and
the insertion point appears.

Editing 6
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2. Begin typing.
The insertion point moves forward as you type each character. You don’t
need to press the Return key at the end of each line. The insertion point
moves forward as you type each character and lines break automatically
between words.

Figure 6-1 Typing at the Insertion Point

3. To start a new paragraph, press the Return key.
This moves the insertion point to the next line.

4. To insert text, click where you want the text.
The insertion point appears where you click.

5. Type at the insertion point.
The text you type is inserted.

.

Figure 6-2 The Insertion Point Was Moved Before Typing

Text you type appears at
the insertion point.

After Return is pressed,
the insertion point moves
to a new paragraph.

The lines in the paragraph adjust
to make room for the next text.
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Deleting and Replacing Text
To delete text, follow these procedures.

1. Put the insertion point directly after the character you want to delete.

2. Press the Backspace key.
This deletes the character to the left of the insertion point. Keep pressing
Backspace to delete additional characters as you want.

Or

1. Select the text you want to delete by dragging across it.
The selection is highlighted. The first example in Figure 6-3 shows you what
correctly selected text looks like.

2. Press Backspace
This deletes the entire selection.

Note – Most text applications provide shortcuts for selecting text. You can
select a word (and the space that follows it) by double-clicking on it or select a
paragraph by triple-clicking on it.

To replace text, follow these procedures.

1. Select the text you want to replace.

2. Type the text with which you want to replace the selection.
As soon as you start typing, the selected text is deleted and the text you
type is inserted in its place.

In some applications, you can use these techniques with graphics. For example,
if you select a graphic and press Backspace, the graphic is deleted.
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Figure 6-3 Replacing Text

Moving and Copying Text
To move text, follow these procedures.

1. Select the text you want to move.

2. Choose Cut from the Edit menu.
The selected text is deleted.

3. Put the insertion point where you want to move the text you cut.
You can also select text you want to replace with the text you cut.

4. Choose Paste from the Edit menu.
The text is pasted at the insertion point, just as though you typed it there.

To copy text, follow these procedures.

1. Select the text you want to copy.

2. Choose Copy from the Edit menu.

Selected text is highlighted to
make it stand out.

Press Backspace to delete
selected text. Or type new text to
replace what you selected.
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3. Put the insertion point where you want to insert a copy of the text.
You can also select text you want to replace.

4. Choose Paste from the Edit menu.
A copy of the text is inserted.

Note – You can choose Paste repeatedly to paste what you last cut or copied as
many times as you like.

Figure 6-4 Cutting and Pasting Text

Changing Fonts
You can change the text font to emphasize key phrases with bold or italics—or
to give the text a different look altogether.

1. Select the text you want to change.

Select the characters you want to
move and choose the Cut
command.

Then choose Paste to insert the
text at the insertion point.
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2. Choose the Font Panel command.
The Font panel command may be in the Format, Font, or other menu,
depending on the application.

3. Click in the Family column to select a font family—a collection of
characters with a consistent design.

4. Click in the Typeface column to select a typeface.
The possibilities include bold, italic, and bold italic.

5. Click in the Size column to select a font size.

6. Click on the Set button to apply the new font to your text selection.
You can also make selected text bold or italic by choosing the Bold or Italic
command in the Font menu.

Figure 6-5 Choosing a Font on the Font Panel

Select a font family in this column

Select a typeface in this column

You can type a type size in this
text field

Or click on a size in this list

Click here to preview the font you
have selected

Click here to undo your font
choices

Click here to apply your font
selection to the text selection
in the document window
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When you work with your computer and applications you create new
documents. This chapter shows you a number of techniques you can use to
organize and reorganize your document files and folders.

Renaming Files and Folders
You can rename an existing file or folder by editing its name in the File Viewer.

1. Select the file or folder you want to rename. You can do this in either the icon
path or the current view.
Its icon is highlighted.

2. Edit the name as you normally edit text.
You can click in the name to position the insertion point; you can also select
the current name and replace it by typing a new one.

3. Press Return.
The new name appears below the selected icon and everywhere else the file
appears.

You may not have permission to rename a file or folder; if so, a panel alerts
you, and the original name is restored. (For information on permissions, see
Using the OpenStep Desktop.)

Caution – Don’t rename an application or the Workspace Manager won’t be
able to start it up when you open a file associated with it.!

Organizing 7
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Figure 7-1 Renaming a File

Click on an icon’s name
and the insertion point
appears.
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Creating a New Folder
You can create folders to keep your files organized and easy to find.

1. Open the folder where you want to create a new folder.
Make sure its icon is highlighted in the icon path.

2. Choose the New Folder command from the Workspace Manager File
menu.
A folder named NewFolder  appears inside the folder you opened.
NewFolder  is selected so that you can edit its name.

If you don’t have permission to change the contents of a folder, the New
Folder command is dimmed in the menu. (For information on permissions,
see Using the OpenStep Desktop.)

3. Type a new name for NewFolder  and press Return.

Your new folder is empty, but you can save new files in it, move or copy
existing files or folders into it, and create other folders in it.
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Figure 7-2 Creating and Naming a New Folder

Moving Files and Folders
You can move files or folders into other folders in the File Viewer—for
example, to move a file into a folder you’ve just created.

1. Select the file or folder you want to move and drag it to the shelf.

2. Select the folder you want to put it in.
The folder’s icon is highlighted in the icon path.

Choose New Folder from
the File menu to create an
empty folder named
NewFolder .

Type a new name for the
folder and press Return.
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3. Hold down the Command key and drag the file or folder you are moving
from the shelf to the highlighted folder in the icon path.
The Command key is the key to the left of the space bar, usually labeled ◆.

The cursor changes color and the folder opens to confirm that the file or
folder will be moved there. If you don’t have permission to change the
contents of a folder, the cursor stays black and the folder’s icon doesn’t
open.

4. Release the mouse button.
The object you dragged is removed from its previous folder and placed in
the folder to which you dragged it.

Note – You can also drag objects you want to move into or out of the current
view.



7-6 Quick Start to Using the OpenStep Desktop—September 1996

7

Figure 7-3 Moving a Folder Icon

The pointer changes
color and the folder opens
to confirm that the file or
folder you’re dragging will
be moved there.
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Copying Files and Folders
To copy a file or folder, follow these procedures.

1. Drag the file or folder you want to copy onto the shelf.

2. Select the folder in which you want to put the copy.
The folder is highlighted in the icon path.

3. Hold down the Alt key and drag the file or folder you are copying to the
folder in the icon path.
The folder icon opens and the cursor changes to a  to confirm that
you’re making a copy.

Note – On a Sun keyboard, the Alt key is the key to the left of the space bar
and command key, and labeled “Alt.” On an X86 keyboard, the Alt key is the
key to the right of the space bar, labeled “Alt.”

4. Release the mouse button.
A copy of the file or folder is created in the folder to which you dragged it.

To make a copy of a file or folder in the same folder, follow these procedures.

1. Select the file or folder you want to copy and choose Duplicate from the
Workspace Manager File menu.
A copy of the selection appears in the same folder with its same name,
preceded by CopyOf .

2. Rename the copy, if you like.

Note – You can also copy an icon from the icon path or current view into a
folder that’s on the shelf.
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Figure 7-4 Copying a File or Folder

Creating a Link to a File or Folder
A link is a picture of a file or folder which appears in a different folder. You can
create a link to a network folder you use frequently and put it in your home
directory. After you create the link, the network folder appears to be in your
home folder, and you can work with it without searching for it in the File
Viewer. To create a link, follow these procedures.

1. Drag the object for which you are creating a link onto the shelf.

2. Select the folder in which you want the link to appear.
This folder’s icon is highlighted in the icon path.

Copying an Edit
document to a floppy
disk. The copy pointer
indicates that you are
copying, rather than
moving.
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3. Hold down the Control key and drag the object you want to create a link
to from the shelf to the folder in the icon path.
The folder icon opens and the cursor changes to a  to confirm that you
are creating a link.

4. Release the mouse button.
A link to the file or folder is created in the folder you dragged it to.

For more information about working with linked files and folders, see Using
the OpenStep Desktop.

Figure 7-5 Putting a Link to 5_May Into Starr’s Home Folder

You know you’re linking a
file or folder—rather than
moving or copying it—if
the cursor changes to an
arrow.
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Deleting Files and Folders
When you no longer want a file or folder, you can delete it from your
computer.

1. Select the file or folder you want to delete.

2. Drag its icon from the File Viewer to the recycler icon.

3. When the recycler’s arrows begin to rotate, release the icon.
The file or folder is deleted. However, it’s not yet gone for good. You can
retrieve it if you want, as described in “Retrieving a Deleted File or Folder”
on page 7-12.

When you recycle a folder, you delete everything in it, including the contents of
all the folders it contains.

You can empty the recycler and destroy its contents for good by choosing the
Empty Recycler command from the Workspace Manager’s File menu. You
should empty the recycler periodically to reclaim disk space.

Note – You can also drag icons from the current view to the recycler.
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Figure 7-6 Deleting EB_draft.rtfd

To remove a file or folder,
drag it to the recycler icon.
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Retrieving a Deleted File or Folder
If you haven’t emptied the recycler, you can retrieve a file or folder you’ve
deleted.

1. Double-click on the recycler icon.
The recycler window opens. It contains all the files and folders you’ve put
in the recycler since you last emptied it. You may have to scroll to find the
file or folder you want to retrieve.

2. Drag the file or folder you want to retrieve to a folder in the File Viewer.
The file or folder reappears in the File Viewer.

Figure 7-7 Dragging a File From the Recycler

To retrieve an object, open the
recycler window and drag it
back to the File Viewer.
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The Colors panel displays the colors available on your computer. This chapter
explains how to select a color on the panel and use it in a document. You can
also “capture” a color you like to the panel and then use it in another
document.

Working with Color
You can open the Colors panel, select a color, and work with it.

1. Choose the Colors command.
This command appears in different menus in different applications. When
you choose it, the Colors panel displays a color wheel. If you don’t see the
wheel, click on the color wheel button .

2. In the color wheel, click on the color you want.
The color you click on appears in the color well. If you drag in the wheel,
the color in the well changes as you drag.

Color 8
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Figure 8-1 Selecting a Color on the Color Wheel

Note – Move around the color wheel to get a spectrum of hues. Drag along a
radius to adjust the saturation (or amount) of one hue. To constrain your drag
to that hue, hold down the Shift key as you drag.

3. In addition to selecting a color, you can modify its brightness and opacity:
• Drag the knob in the brightness slider—or click in the bar—to make the

current color lighter or darker.
• Drag the knob in the opacity slider—or click in the bar—to make the

current color more opaque or transparent. If your application doesn’t use
opacity, this slider doesn’t appear in the Colors panel.

For details about applying a color in a document, see “Using Color in Your
Documents” on page 8-4. The following pages describe other ways to select
colors as well as ways to save colors you’ve selected so they’re easy to retrieve.

Capturing a Color From the Screen
If you see a color on the screen that you would like to use, you can capture it
with the Colors panel.

The color you select
appears in this color well.

Click on the color wheel to
select a color.
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1. Choose the Colors command and click on the magnifying glass button.
The mouse pointer changes to a magnifying glass shape.

2. Move the magnifying glass to the color you want to capture from the
screen.
The color should be centered in the crosshairs as shown in Figure 8-2.

3. Click the mouse button.
The screen color becomes the current color in the color well.

Figure 8-2 Capturing a Color With the Magnifying Glass

After capturing a color you can apply it directly to a document or save it in one
of the color swatches on the panel.

Saving a Color in a Swatch
After selecting a color on the wheel or capturing it from the screen, you can
save it in a color swatch to use later.

Click on the magnifying
glass button. The pointer
changes to the magnifying
glass shape.

Move the magnifying class
until the crosshairs are over
the color you want to capture.
Then click the mouse button.

The color you capture fills the
color well on the Colors panel.
Now you can drag it to another
object or save it in a swatch.



8-4 Quick Start to Using the OpenStep Desktop—September 1996

8

♦ Drag from the color well to the swatch bar at the bottom of the panel.

As you drag, a small color sample appears under the pointer. When you
release the mouse button, the color appears in the swatch bar. Color
swatches are saved until you replace them with new swatches.

The next time you open the Colors panel—whether in the same application
or in another one—the same colors will still be in your swatches.

Figure 8-3 Dragging From the Color Well to a Swatch

Note – You can enlarge the Colors panel to increase the number of swatches
you can use.

Use the colors in your swatches by dragging them to documents (See “Using
Color in Your Documents” on page 8-4).

Using Color in Your Documents
If your application has a Colors panel, you can use it to change the color of text
and other objects in your documents. For example, you can include color text
in memos you send in Mail or in articles you write in Edit.

Move the pointer to the
color well and press.

Drag to a swatch and release
the mouse button.
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1. Select the text whose color you want to change.
(For more about selecting text, see Chapter 6, “Editing.”)

2. Choose the Colors command.
The Colors panel opens.

3. Select the color you want.
The color you select appears in the color well.

Figure 8-4 Applying a Color to a Document

4. Drag the color from the color well to the selected text.
The selected text changes to the current color.

Dragging from the color well to another color well or to a selection is the
standard way to change colors. You also use this method to change the color of
selected graphics and other objects in other applications.

Point to the color well or a color
swatch and press the mouse button.

Drag the color to selected text
to change its color.
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Preparing a File for Printing
Before you print a file, you can make a few choices about how you want your
pages to appear.

1. Open the file you want to print and choose Page Layout.
The Page Layout command is usually in an application’s main menu or its
Format submenu.

This Page Layout panel displays the current page layout settings for the file.
The paper dimensions are shown in the Width and Height fields.

2. Review the current settings and change any to make the printed copy
more useful.
The standard options are illustrated and explained in Figure 9-2

Some settings affect your pages on screen, while others take effect only
when you print.

3. Click on OK.

Printing 9
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Figure 9-1 The Edit Page Layout Panel

Printing a File
You can print a file on a printer that’s connected directly to your computer or
that’s available on the network.

1. Open the file you want to print and choose Print from the main menu.
The Print panel opens.

2. Review the current settings and change any to make the printed copy
more useful.
The standard options are illustrated and explained in Figure 9-2.

The current orientation of
your paper.

Shows the paper size currently
selected. If you press on the button, a
list of other possible paper sizes
appear.

Displays the paper size.Change it by
typing over the current values.

Click on Cancel to close the panel
without making any changes or click on
OK to apply any changes.

Change the paper
orientation by clicking on
one of these buttons.

Change the unit for paper size by
pressing on the button and dragging to
another unit in the pop-up list.



Printing 9-3

9

3. Click on Print.

For more information about printing, see Using the OpenStep Desktop.

Figure 9-2 A Typical Print Panel

The name of the current
printer.

Specify a page range.

Click to save the settings
you choose in the Print
panel.

Click to preview the
document before you print it.

Click to close the panel
without printing the
document.

Click to print the
document.

Type the number of copies
you want in this field.

Available printers.

Job status

Printer
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